INTRODUCTION TO WORD
# Contents

**Getting Started** .......................................................................................................................... 1  
**The Ribbon** ................................................................................................................................. 1  
**The Ruler** ..................................................................................................................................... 2  
**The FILE tab** .................................................................................................................................. 3  
Creating a New Document .................................................................................................................. 3  
Selecting the language. .................................................................................................................... 3  
Screen Layout ...................................................................................................................................... 4  
Quick Access Toolbar .......................................................................................................................... 4  
Create Sample Text ............................................................................................................................ 5  
Saving and Closing Work .................................................................................................................... 5  
Opening an Existing Document .......................................................................................................... 6  
**Manipulating Text.** ....................................................................................................................... 7  
**Inserting Text** .................................................................................................................................. 7  
Selecting Text ...................................................................................................................................... 7  
Copy and Paste Text: ........................................................................................................................... 7  
Cut and Paste Text: .............................................................................................................................. 8  
Deleting Text ....................................................................................................................................... 8  
Undo Changes ..................................................................................................................................... 8  
**Paragraph Formatting** ................................................................................................................. 9  
Change Paragraph Alignment ............................................................................................................. 9  
Paragraph Indent ............................................................................................................................... 9  
**Font Formatting** ............................................................................................................................ 10  
Font type .......................................................................................................................................... 10  
Font size .......................................................................................................................................... 10  
Font Effects ....................................................................................................................................... 10  
Change Text Colour ........................................................................................................................... 10  
Copy Formatting ............................................................................................................................... 11  
Line Spacing. ..................................................................................................................................... 11  
Further formatting options ................................................................................................................. 11  
**Inserting a Table of Contents.** ..................................................................................................... 12  
**Styles** .......................................................................................................................................... 12  
**Table of Contents** .......................................................................................................................... 13  
Built-In Heading Styles ...................................................................................................................... 14
Update Table of Contents .......................................................................................................................................................................................... 14

Creating a New Style ......................................................................................................................................................................................... 15

Tables ........................................................................................................................................................................................................ 17
  Creating a Table .......................................................................................................................................................................................... 17
  Entering Data in a Table ........................................................................................................................................................................ 17
  Modify and Format a Table .................................................................................................................................................................. 17

Symbols and Special Characters .................................................................................................................................................................. 19
  Special Characters ................................................................................................................................................................................... 19

Pictures ............................................................................................................................................................................................................. 20
  Insert a picture: .......................................................................................................................................................................................... 20
  Repositioning Pictures ........................................................................................................................................................................... 20
  Formatting a picture ............................................................................................................................................................................... 21
  Resize Graphics ....................................................................................................................................................................................... 21
  Insert a caption under the image .......................................................................................................................................................... 21

Spelling and Grammar .................................................................................................................................................................................. 22
  Thesaurus .................................................................................................................................................................................................. 23
  Word Count .................................................................................................................................................................................................. 23

Page Borders ........................................................................................................................................................................................................ 24

Header and Footer ....................................................................................................................................................................................... 25
  The Footer .................................................................................................................................................................................................. 25
  Header & Footer Tools – Design Tab ...................................................................................................................................................... 26

Page numbering .................................................................................................................................................................................................. 26

Section Breaks .................................................................................................................................................................................................. 27
  Changing the headers between sections .................................................................................................................................................. 27
  Changing the footers between sections ................................................................................................................................................ 29
  Insert a Blank Page ................................................................................................................................................................................... 30
  Insert a Cover Page .................................................................................................................................................................................. 30
  Custom Cover Page .................................................................................................................................................................................. 31

Bulleted and Numbered Lists .................................................................................................................................................................. 32
  Formatting Lists .................................................................................................................................................................................................. 32

Referencing ......................................................................................................................................................................................................... 33
  List of Citations (Works Cited) ............................................................................................................................................................... 35
Getting Started

The Ribbon
This is the wide panel across the top of the screen below the Quick Access Toolbar. The top portion of the ribbon contains tabs:

Home, Insert, Design, Layout, References, Mailings, Review, View and more.

Each tab contains panels of grouped commands, the grouping of which is based on similarity of function.

E.g. The HOME tab contains the following groups: Clipboard, Font, Paragraph and more.

To view additional features within a group left click on the arrow at the bottom right of the group (as seen below).

In this example the Paragraph dialog box opens.
The Ruler

The ruler is found below the Ribbon.

If your ruler is not visible, click the VIEW tab; go to the Show grouping and select Ruler.

You can use the ruler to change the format of your document quickly – do this by hovering the cursor over the triangle shaped tabs at each end of the document on the horizontal and the vertical bar and left clicking and moving the tabs.

**EXERCISE**: adjust the margins on your page using the ruler.
The FILE tab

Click the **FILE** tab and the options to the right appear.

Creating a New Document

Click **“File”**

To create a new blank document click **“New”**, then click **“Blank Document”**.

Selecting the language.

Check the language setting on your document as sometimes it can be English (American) and there are some distinct spelling differences.

Go to the **FILE tab**, select **Options**, click Language and you get the options below.
Quick Access Toolbar

The quick access toolbar contains commands that are used regularly (e.g. Undo, Redo, Save)

You can add more commands to this toolbar, click here to access the drop down menu

Or right click on any tool or group on the ribbon to open the dialog box below.
Then left click the option Add to Quick Access Toolbar.
EXERCISE: add at least three new buttons to the Quick Access Toolbar.

Create Sample Text

To enter text, just start typing! The text will appear where the blinking cursor is located.

Microsoft word has sample text available for insertion (to save typing)

Place the blinking cursor at the position where the sample text is required and type the following characters: \texttt{=rand(10,8)}

Press the enter key to see the paragraphs of sample text appear in the document.

Saving and Closing Work

While working on any document you should SAVE it as you work –

DO NOT LEAVE IT TILL THE END OF YOUR SESSION!!

Click the FILE Button and select ‘Save As’, you will be asked where to save your document to as shown.

You can also name your document.

EXERCISE: save your work in your own name in the following format: surname\_forename\_wk1

Save it to Document folder on your computer – if this does not appear as an option simply click ‘Browse’

The first time you save a document it must be named and the ‘Save As’ function allows you to do this while also choosing the location where you want the document to stored.

The next time you open this document and edit it, you only have to select ‘Save’ (top left-hand corner icon) and all changes are saved but the document retains its original name.

Save your work regularly!!
Opening an Existing Document

From the File click “Open” and browse to the location where the document is stored.

Note:
When working on a document that has already been created and named, it is essential to save your work regularly to avoid data loss in the event of a power failure (or other event). To do this click the quick save icon on the quick access toolbar.
Manipulating Text

Type the following characters =rand(10,8)

This will generate text on the page for you to manipulate.

Inserting Text

Text can be inserted in a document at any point using the following methods:

- Place the **blinking cursor** at the required position and begin typing.
- Use the arrow buttons on the keyboard to place the cursor where required and begin typing.

Selecting Text

The following table contains shortcuts for selecting a portion of text:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Technique</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole word</td>
<td>Double-click within the word</td>
</tr>
<tr>
<td>Whole paragraph</td>
<td>Triple-click within the paragraph</td>
</tr>
<tr>
<td>Several words or lines</td>
<td>Drag the cursor over the words while keeping the left mouse button depressed or hold down the <strong>SHIFT</strong> key on the keyboard while using the arrow buttons to highlight the text.</td>
</tr>
<tr>
<td>Entire document</td>
<td>Press CTRL+A</td>
</tr>
</tbody>
</table>

Deselect the text by clicking anywhere outside of the selection on the page or press an arrow key on the keyboard.

Copy and Paste Text:

- **Select the text** to copy
- **Right click** on the highlighted text to activate the mouse drop-down menu and click **Copy**.

- Place the cursor at the position where the text is to be copied to. **Right click** to activate the mouse dropdown menu and click **Paste**.
Cut and Paste Text:
(Used to move text within a document or to extract text for use in another document)

- Select the text to extract (cut)
- Right click on the highlighted text to activate the mouse drop-down menu and click Cut.
- Place the cursor at the position where the text is to be moved to. Right click to activate the mouse drop-down menu and click Paste.

EXERCISE:
- Triple click to select the first whole paragraph, CUT the first paragraph and move it to the end of the document.
- COPY any other paragraph and move it to the beginning of the document.

Deleting Text
Use the BACKSPACE and DELETE keys on the keyboard to delete text.

Backspace will erase text to the left of the cursor Delete will erase text to the right.
To delete a large amount of text, select it and press the DELETE key.

Undo Changes
The Undo Button, on the Quick Access Toolbar, is useful for undoing errors made, starting with the last error and working backward by means of consecutive mouse clicks.
**Paragraph Formatting**

Paragraph formatting allows a number of useful options to be applied which can considerably alter the appearance of a document.

**Change Paragraph Alignment**

Align Left, Centre: Useful for main headings, Align Right

**Justify**: Aligns text to both the left and right margins and is recommended for use in academic submissions.

**Paragraph Indent**

Paragraph indent allows formatting of the text margin within a paragraph to a variety of settings.

To indent a paragraph, do the following:

Place the blinking cursor before the first word and Click the **Increase Indent** button.

**EXERCISE**: indent every second paragraph.
Font Formatting

Font is the word used to describe the actual shape of the letters that appear on the screen when typing. Fonts have different names like Calibri, Times New Roman, Arial and Verdana.

Font type

Select the HOME tab and highlight the required text

Click the arrow next to the font name and choose a font.

To preview how the new font will look hover the cursor over it before applying it.

Font size

Select the required text.

Click the arrow next to the font size and choose the appropriate size, or

Click the increase or decrease font size buttons. (A A)

Font Effects

Predefined formatting options allow text to be emphasized in a variety of ways including: **Bold**, *Italic*, and _Underline_.

To apply any of these to text:

Select the text and click the appropriate button on the Font group on HOME tab

Change Text Colour

To apply a different colour to text, select the required text

Click the down arrow next to the font colour button

Click on a suitable colour from the colour chart
Copy Formatting

Occasionally it may be useful to apply formatting from one font set to another. To do this use the **Format Painter** icon in the **Clipboard** grouping on the **HOME** tab.

1. Select the required text.
2. Copy the format of the text by clicking the **Format Painter** button.
3. Apply the copied format by selecting the required text and clicking on it.

---

**Line Spacing.**

Click **HERE** to access a drop-down menu for line spacing. Recommended line spacing for an academic submission is “1.5 Lines.”

---

**Further formatting options**

To access further formatting options, on the **HOME** tab, open the **Paragraph** dialog box by clicking on the arrow at the lower right corner of the paragraph group.

---

**EXERCISE:**

- Select a paragraph and change the font to Times New Roman size 14, underline it and make it bold, change the spacing of a paragraph to 1.5, and another to 2.
- Change various words to various colours.
- Select another paragraph and do the same with a font and size of your own choosing.
- Undo a couple of your last changes.
Inserting a Table of Contents

Styles
The use of Styles in a document allows for consistent formatting to be applied throughout the document. When used correctly, Styles also enables you to insert a Table of Contents without the need to type it.

Word comes with pre-formatted “Styles” which can also be customised to suit individual preferences.

To view a range of pre-formatted styles click the More button on the Styles Group in the Home Tab.

Style Sets
A “Style Set” consists of a number of pre-formatted individual styles with commonality of theme e.g. “Heading 1”, “Heading 2”, “Heading 3” To apply a style:

1. Place the blinking cursor at the start of the applicable text
2. Select a Style by clicking on it e.g. “Heading 1”.
   (Or, move the mouse arrow over any style to preview the result before selecting it)
Table of Contents

MS Word provides a facility for the automatic generation of a Table of Contents, (TOC). The TOC is placed after the cover sheet and before the Introduction/Overview. Even though it appears after the cover sheet it is the last item to be inserted. Should any alterations be made to text within the document after generating the TOC it is important to update the TOC before printing.

In order to generate a Table of Contents automatically the headings and sub-headings in the document have Heading Styles applied to them which makes them identifiable for inclusion in the TOC.

TYPE =rand(6,10)

• Double click on the word ‘Video’ to highlight it.
  ▪ Go to the ‘Styles’ grouping in the HOME tab and select ‘Heading 1’
  ▪ Do this for all paragraphs where the word ‘Video’ is the first word.

• Double click the word ‘To’ to highlight it.
  ▪ Go to the ‘Styles’ grouping in the HOME tab and select ‘Heading 2’
  ▪ Do this for all paragraphs where the word ‘To’ is the first word.

• Double click the word ‘Click’ to highlight it.
  ▪ Go to the ‘Styles’ grouping in the HOME tab and select ‘Heading 3’
  ▪ Do this for all paragraphs where the word ‘Click’ is the first word.

Place the cursor where you want the Table of Contents to be – usually after the Cover Sheet near the start of the document,

Open the REFERENCES tab, click ‘Table of Contents’ in the left most grouping, select the first option.
Built-In Heading Styles

The built-in styles enable you to automatically generate a Table of Contents within the document. Normally the following will apply:

Main headings such as Chapter headings should be set to “Heading 1” style.

Paragraph Headings are set to “Heading 2” style.

Sub-paragraph headings to “Heading 3” style

Update Table of Contents

If you have added or removed headings or other table of contents entries, you can update the table as follows:

1. Click the References Tab in the Ribbon

2. Click Update Table

OR … right click on your TOC and select ‘Update Field’

and then ‘Update entire table’
Creating a New Style

While default formatted styles are useful, individual requirements often demand the creation of new styles. When creating a new style ensure that the cursor is in a blank area of the screen otherwise the new style will be applied to the wrong text.

1. Click into the Styles grouping

2. Click Create a Style and click Modify

3. Complete the New Style dialog box by entering a new name here and you can then make changes to the different sections as you require, there are also options to limit the new style to this document only

4. Note the options at the bottom of that dialog box:
   - Add to Quick Style List
   - Only (available) in this document
   - Automatically update
Word-processing

- Font
- Size
- New name here
- Single line spacing
- 1.5 line spacing
- Double spacing

Text alignment options

Paragraph indent
Tables

Tables are used to display data in a tabular format and while cell outlines are often the means of readily identifying such a table, it is possible to use tabulated information without cell borders thereby providing a means of presenting data in various formats.

It should be noted that tables generated from within a word-processor do not have the functionality of those generated within a spreadsheet package. (More on this later)

Creating a Table

Place the blinking cursor at the required insertion point
Click the INSERT Tab of the Ribbon
Click the Table Button on the Tables Group.

A table may be created by one of a number of methods:

1. Highlight and Click the number of rows and columns you require

2. Or Click Insert Table and enter the number of rows and columns, then Click OK to generate the table.

Entering Data in a Table

Place the cursor in the cell where you wish to enter the information and begin typing.

| Simply type text to have it automatically wrap within a cell. |

Modify and Format a Table

To modify the structure of a table:

Click the table and notice that two new tabs appear on the Ribbon: Design and Layout. These relate to the table design and layout.
Selection of the **Design Tab** presents the following groups:

1. Table Style Options
2. Table Styles
3. Borders

This feature enables you to change the design of the table.

To format a table, **click the table** and then click the LAYOUT Tab (this tab only appears when you click into the table, not to be confused with the LAYOUT tab that is on the ribbon between DESIGN and REFERENCES) on the Ribbon and you will see the following groupings:

There are many options here to explore – an interesting one is the **Alignment** grouping as you can change the position and direction of the text within a table.
Symbols and Special Characters

These are not generally available on the standard keyboard. To insert a symbol into a document:

1. Place your cursor in the document where you want to place the symbol
2. Click the **INSERT** Tab, the **Symbols** grouping, Symbol
3. Choose the required symbol.

**Special Characters**

(Equations)

Presentation of mathematical equations is catered for by means of the Equation button.

To insert an equation:

1. Place the blinking cursor in the document where you want to place the equation
2. Click the **INSERT** Tab on the Ribbon
3. Click the **Equation** Button on the Symbols Group
4. Choose an equation from the default set or **Click Insert New Equation**

Use the tools from the design tab to generate custom equations. E.g. $A = B + C^2$
Pictures

Insert a picture:

1. Place the blinking cursor in the document at the insertion point.
2. Click the INSERT Tab on the Ribbon
3. In the Illustrations groupings click the Pictures Button
4. Browse to the picture you wish to insert
5. Click on the picture/image
6. Click Insert

Repositioning Pictures

When a picture or image is inserted into a Word document it is usually aligned to the Left Side of the page. It is possible to position the picture anywhere it is required and even to have it behind or in front of text.

Figure 1: Right Click the picture which displays a Drop-Down Box as shown

Figure 2: Select Wrap Text and then choose an option from the dialog box that appears to the right. One of the most common selections is Square which allows pictures to be dragged and dropped most locations within a document.

The Illustrations grouping under the INSERT tab also has other items that can be inserted into a document – Online Pictures; Shapes; SmartArt; Chart and Screenshot.
Formatting a picture.

When a Picture is inserted into a document a FORMAT tab appears.

Click the FORMAT tab and a number of groupings are there.

Go to the Size grouping and click Crop.

Grab the borders and move them inwards, when satisfied click Crop and the image will be cropped.

There are a number of other options in the FORMAT picture tab – if you are using pictures or images you should familiarise yourself with these options.

Resize Graphics

All graphics can be resized by clicking the image and clicking one corner of the image and dragging the cursor to the desired size.

Insert a caption under the image

Select the image

From the REFERENCE tab select Insert Caption

In the caption dialog box Figure 1 is automatically generated

You can add text here or leave it as is

When you are satisfied click OK

and appears beneath the image

Exercise:

Insert at least 4 pictures into your document, assign them captions and generate a Table of Figures.
Spelling and Grammar

To check the spelling and grammar of a document

1. Place the cursor at the beginning of the document or the beginning of the applicable section that you want to check
2. Click the REVIEW Tab on the Ribbon
3. Click Spelling & Grammar in the Proofing group.

4. Errors will display in a dialog box that prompts you with possible choice of more appropriate spelling or phrasing.

5. To check the spelling of an individual word, right click any word that has been underlined and choose a substitution.
**Thesaurus**

The thesaurus function presents suggested synonyms (alternative words with similar meaning)

To use the thesaurus:

1. Click the **REVIEW** tab of the Ribbon
2. Click the **Thesaurus** Button on the **Proofing** group.

3. The thesaurus tool will appear on the right side of the screen.

The thesaurus can also be accessed by right clicking any word and choosing **Synonyms** on the menu.

**Word Count**

To check the word count in a document, look at the bottom left corner of the screen. It will give you a total word count or if you have some text selected it will show how many words are in the selection.

In this example the total word count is 4,275 with 46 words selected
Page Borders

To apply a page border:

1. Click the LAYOUT tab on the Ribbon

2. In ‘Page Setup’ group click on the arrow for more options

3. Select ‘Layout’

4. Click Borders

5. You can now select what you want to do with your page or whole document.

6. Insert a border on your document — mess around with the options e.g. do a 1.5 weight line around all your pages.
Header and Footer

Headers and Footers can be included to provide information for the reader. Start with a Header:

1. Click the **INSERT** tab on the Ribbon
2. Click the **Header** button
3. Choose the second style and type in your name in the left area, type in **WORD** in the centre and type in your course code in the right-hand side.

It is possible to simply click into the top or bottom of a document and activate the header/footer feature. You normally have to click into the greyed-out area on your vertical ruler for this to occur.

The Footer

The footer area is normally used for the page-numbering feature, which is usually aligned right. Other information can also be included depending on which footer is used.

The **Header/Footer Design** Tab will display on the Ribbon when Header/Footer is active

It will be noted that Page Numbering and the prompt Link to Previous are visible in both the Header and Footer areas.
Header & Footer Tools – Design Tab

A number of options are selectable that allow individuality to be applied to different sections.

When **Link to Previous** is visible this indicates that the current Header or Footer section is electronically tied to the previous one and therefore contains identical data. The **Link to Previous** option must be removed if the content of the current section Header and/or Footer is to differ from the previous.

To remove the **Link to Previous** option, click the **Link to Previous** button.

---

Page numbering

**Main points to note:**

1. In a report that contains a cover page and a Table of Contents page, numbering normally starts after these, on the first page of the actual content.

2. Right alignment is normally used.

3. For **Start at**, Enter 1
   
   i.e. page 1 to start after the table of contents

---

When finished you close the **HEADER & FOOTER** tab here.
Section Breaks

Section breaks divide a document electronically thereby allowing individual header and/or footer information to be applied to different parts of a document. It also allows you to change the formatting between sections.

**EXERCISE:**

To begin, right click on the status bar at the bottom of your document, from the pop-up screen select ‘Section’ and make sure there is a ✓ there.

On a blank page type =rand(20,8) and press Enter/Return. (20 paragraphs of 8 lines each.)

Place the cursor at the end of the text on the first page.

1. Click the LAYOUT tab on the Ribbon
2. On the Page Setup group, click the Breaks
3. Under Section Breaks select Next Page (Your cursor should appear at the beginning of the text on the next page.)
4. Go to LAYOUT tab, select Orientation and click Landscape – the pages only in this section will change orientation.
5. Place the cursor at the end of the text on page 3, open the LAYOUT tab, click Breaks, select Next Page, select Orientation and select Portrait – the remainder of the document should change back to portrait.

**Changing the headers between sections**

It is possible to use different headers and footers in the same document by using Section Breaks. Following the last exercise now do the following:

- Go to the first page, click INSERT tab, select Header, select the first option and enter your name; close the Header & Footer tab.
- Your document now has a header throughout including the pages in landscape.
• Now insert the page numbers and close the **Header & Footer** tab.

To change the headers and footers between sections do the following:

Go to the first page oriented in landscape, double click into the Header area to open the Header & Footer Design tab. On your page you will see ‘**Same as Previous**’ here.

This is telling you that your Header is linked to the previous page. To unlink it, click **Link to Previous**.
You will see that the tab ‘Same as Previous’ should disappear.

You can now edit/change your header, close it and you will see that it is different from the first section.

To go further with this –

Go to the last page which is portrait orientation.

Click into the Header, click ‘Link to Previous’ to uncouple it from the previous section, watch for the words ‘Same as previous’ to disappear; edit your header once more; close the Header and Footer tab and you should see that you now have three headers in your document.

Changing the footers between sections

Click into your footer which opens the Design tab

Click the Page Number button here:

Select ‘Format Page Numbers’

Change the number format here

Select the Roman numerals

Only the page number on the first page will change as this is a separate section. The second page will still appear as ‘2’ and so on. It is possible to change this by following the instructions below.
Click into the Footer to open the Design tab.

Click Page Number and select Format Page Numbers.

On the pop-up menu click ‘Start at’ here

This uncouples this section from the previous section, and you can start the page numbers at any number. Select ‘1’ and you will see that the page numbers change.

In most academic reports you will have no page number on the Cover Page, you will then use Roman numerals (i, ii, iii, iv, etc) on your Table of Contents and you will then use Arabic numbers (1, 2, 3, 4, etc) on the main body of your report. This document you are reading is a good example of this.

**Insert a Blank Page**

To insert a blank page:

1. Place the Blinking Cursor at the required position
2. Click the Insert Tab on the Ribbon
3. Click the Blank Page Button on the Page Group

**Insert a Cover Page**

To insert a cover page from a set of default samples:

1. Click the INSERT tab on the Ribbon
2. Click the Cover Page Button on the Pages Group
3. Choose a style for the cover page
Custom Cover Page

Submission of project work may require the inclusion of a course specific cover sheet. To add a custom cover sheet to the MS Word default set:

1. Open the electronic copy of the required cover sheet.
2. Check the content formatting has not been distorted.
3. Highlight All (ctrl + a) of its content
4. From the INSERT, select Cover Page
5. Select **Save Selection to Cover Page Gallery**
6. Enter a suitable -
7. Click **OK**

The new entry should now appear within the default gallery.
Bulleted and Numbered Lists

Insert some random text using the following formula \( \text{rand()} \) To add a bulleted or numbered list to the text:

1. Select the text
2. HOME tab, from the Paragraph Group click the **Bulleted or Numbered Lists** button

**Formatting Lists**

The bullet image and numbering format can be changed by using the **Bullets or Numbering** dialog box.

1. Select the entire list to change all the bullets or numbers or place the cursor on one line within the list.
2. Click the dialog box (highlighted to the right)
3. Change the requirements from the menu.
Referencing

(Author, Date) style referencing is catered for in MS-Word whereby the word processor allows one to “Cite-As-You-Write” as follows:

Sample text. Note the reference in parenthesis (brackets):
“It could be argued that all academics with good first degrees and higher degrees will have developed the ability to write for scholarly publication” (Murray, Thow, Moore, & Murphy, 2008)

To have MS-Word automatically insert the citation (displayed in parentheses) above:

1. Select the REFERENCES tab
2. In the Style box, select APA
3. Place the blinking cursor at the point in the document where you want the reference to appear.
4. Select Insert Citation
5. Select Add New Source and the Create Source window opens.

Note: it is essential that you choose the correct Referencing Style at this stage as you cannot change it afterwards. Check what style you should be using Harvard, APA or IEEE.

Select Type of Source for the drop-down menu of options and select Journal Article
Enter the required information and to enter the Authors full name click EDIT.

Enter the Authors details, use initials if you do not have the full name.

Click Add button and repeat for each author.

When finished press OK.

Create a citation for the following:

Author: Your Name
Title: Investigating work based learning.
Journal name: Journal of Work Place Learning
Year: any year you like.
Pages: 100 - 110

Type =rand() and press ENTER.

Place the cursor at the end of the first paragraph; go to the REFERENCES tab, click Insert Citation and the citation will appear.

You generate a second citation for another journal article – you make up the details.

Go to any sentence in the second paragraph and insert a citation from the one you just created.
List of Citations (Works Cited)

This comes at the end of the document just before any appendices. It is also known as a Reference List.

Place the blinking cursor where the List of References is required and from the References tab

1. Select Bibliography
2. Select Works Cited

All references entered throughout the document will auto-populate the Works Cited list alphabetically.

Works Cited


Email me Robert.hickey@tudublin.ie a copy of your saved files from this workbook